RefWorks 2.0 Step-By-Step

A. Setting up an Account and Logging In

2. Click on Sign Up For An Individual Account on RefWorks 2.0. If you are connecting from off-campus, you will be asked to login to ALADIN at this point. At the RefWorks Logon Screen, again select Sign Up For An Individual Account.
3. Fill out the form, then click on Create Account.
4. You should already be logged in to RefWorks after registering, if not, log in.

B. Adding References to RefWorks

1. Direct Export from EBSCOHOST Databases

From an EBSCOhost database, such as Academic Search Premier, construct your search as usual. As you find citations you're interested in capturing into RefWorks 2.0, add these to your folder by clicking on the Add to folder icon at the bottom of the citation.

When you have finished adding citations to your EBSCO folder, click on Folder View.

From the folder view, check mark the items you wish to export (or select all), and click Export.

Then Click Save in the right hand menu. The citations will then show up in your Last Imported folder in RefWorks.

For help: refworks@gwu.edu
2. Direct Export from Proquest Databases

From a Proquest Database, such as Proquest Research Library, run your search as usual. Mark the citations you are interested in saving using the check boxes.

When done, click on the Export icon.

Then click on the Export directly to Refworks link. The citations will then show up in your Last Imported folder in RefWorks.

3. Direct Export from the Surveyor Catalog

From the Surveyor Catalog, run your search as usual. From the results screen, mark the records you would like to save using the check box. Then click the dropdown at the top of the page - Select an Action and select Export selection to Refworks.

4. Export from the Classic ALADIN Catalog

The ALADIN catalog is one of the databases that does NOT allow for direct export into Refworks. Instead you export a text file and import that file into Refworks as follows:

  a) From your result list in the ALADIN catalog, mark the records you wish to save.

  b) At the bottom of the page, choose Full Record as the download format.

For help: refworks@gelman.gwu.edu
c) Choose either Selected on Page or Selected on All Pages.
d) Click Format for Print/Save.
e) Make sure to save the data as a text file.

<table>
<thead>
<tr>
<th>Records</th>
<th>Select Download Format</th>
<th>Print/Save Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>All on Page</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selected On</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selected all</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Consortium.

i) For the Select Text File, Browse to where you saved your Classic Catalog text file
download. Select that text file.
j) Click Import. You may specify one of your Refworks folders to receive imported records.

For directions on importing from other ALADIN databases, please see the Exporting References
tab on the Research Guide: http://libguides.gwu.edu/refworks

5. Manually creating a new reference

a) Go to the References menu
b) Click on Add New Reference
c) Choose the citation style that you
normally use under the View fields
used by drop down menu. This will
show you the required fields for
data entry for your particular style.
d) In the Ref Type drop down menu,
choose the reference type, such as journal article or book chapter, that you will be
entering.
e) Enter the information from your reference in the appropriate fields.
f) Click on Save Reference at the bottom of the page.
g) Repeat these steps to add another.

6. Save and Import a Web Page using RefGrab-It

RefGrab-It works with the Internet Explorer or Firefox browsers to capture bibliographic
information from web pages, giving you the option to import that data into your RefWorks
account. RefGrab-It has to be downloaded prior to use. To do that, go to Tools > RefGrab-It and
follow the directions to download and enable the link on your browser’s toolbar. To use
RefGrab-It, go to the website that you’d like to import and click the RefGrab-It button in your
browser.

For help: refworks@gelman.gwu.edu
C. EDITING REFERENCES

After importing references, you may find that:

- Some of the data necessary for a citation is incomplete or incorrect
- You want to add searchable “Descriptors” or other tags to the citation for your own use
- You may want to cut+paste portions from the full text of the article
- You need to add some annotation or your own personal notes to the citation

To do so:

1. In the list of references, click on the Pencil Icon on the right side of the reference you need to edit.
2. Make your changes to any fields you desire
3. Click Save Reference at the bottom of the screen.
4. Note: If you wish to add full-text to your reference, first you must download the full-text to your computer as normal. Click on the Edit link on the right-hand side of your citation in Refworks. Use the Attachments field. Click the Browse button and select the file. Click Add Attachment. The article will be saved online in your Refworks account. Note: an individual file cannot exceed 20MB, and the default total size limit for each user is 1 GB. Attachments will not be visible to others if you use RefShare.

D. USING FOLDERS IN REFWORKS

Folders are a handy way to keep research projects separate from each other. References can be in more than one folder. When you import references, they will automatically be placed in a Last Imported folder and will stay there until you import more references, at which point they will be grouped together as References Not in Folder.

1. Creating a folder:
   1. Click on the New Folder Button.
   2. Name your folder(s) and click Create.
2. Putting references in folders:
   1. Go to View/Folders and click Last Imported or References Not in Folder.
   2. Select those items you'd like to move into a particular folder by checking the box beside each one. Make sure the Selected Radio button is checked.
   3. Click on the folder with the + Symbol and select the folder you want from the resulting dropdown list.

E. Searching and sorting your references in RefWorks

You can search across your RefWorks database or within specific folders for references by author, title, journal, keyword, etc. To help you find what you need, you can also add your own descriptor tags.

1. Adding descriptors to references:
   1. Navigate to the appropriate folder.
   2. Click on Global Edit (Globe Icon with Pencil indicated by arrow here)
   3. Select the appropriate choice from References to Edit
   4. From here you may Add, Move, Delete or Replace information in each Reference.

2. Searching References:
   1. Click on Search in the RefWorks toolbar and click Advanced Search.
   2. Enter in search terms
   3. Select whether you would like to search across your account or in a particular folder
   4. Click Search

3. Searching RefWorks with the Lookup function:
   1. You can search for your references in RefWorks by author name, descriptor heading or by periodical title. For example, go to Search and then click Lookup by Periodical.
   2. Browse through the list of periodicals, click on the periodical name you are interested in. You will then see the reference associated with that journal title.
   3. You can also edit authors, descriptors, and

For help: refworks@gelman.gwu.edu
periodical titles globally by using the Lookup function. Click the Edit icon next to an item to change the way it appears in all the references to which it pertains—e.g., if an author’s name is misspelled.

4. Sorting your references
   1. From within one of your folders, you can sort references many different ways. Click on the dropdown to select your desired option. Selecting Periodical, Full will sort your results by journal title.

F. Applying References to Your Paper

1. Create a stand-alone bibliography
   1. Click the Create Bibliography button from the RefWorks menu bar.
   2. Choose an Output Style for the references—for example APA. If you do not see the output style you want in this list, select Output Style Manager to see the full list.
   3. Under the heading Format a bibliography from a list of References, set the File Type to Create drop-down menu to the appropriate format (e.g., Word for Windows)
   4. Choose which references you would like to include—All, Selected, or references From Folder...
   5. Click Create Bibliography. Refworks will tell you when the bibliography has been created.
   6. If it doesn’t open automatically in a new window, click Download It then Save to save the file to your desktop.
2. **Using Write-N-Cite**

*Write-N-Cite* is a utility that acts as a bridge between RefWorks and Microsoft Word, allowing you to place citations within your research paper as you write it.

Write-N-Cite is available in four versions:

<table>
<thead>
<tr>
<th>Write-N-Cite III for Windows:</th>
<th>Write-N-Cite Version II for Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>- MS Vista and Word 2007 compatibility</td>
<td></td>
</tr>
<tr>
<td>- Also compatible with XP and Word 2003</td>
<td></td>
</tr>
<tr>
<td>- Single document formatting</td>
<td></td>
</tr>
<tr>
<td>- Faster formatting for large documents</td>
<td></td>
</tr>
<tr>
<td>- Includes ability to write and format papers offline</td>
<td></td>
</tr>
<tr>
<td>- Two document formatting (draft and final versions)</td>
<td></td>
</tr>
<tr>
<td>- Compatible with XP and Word 2003 and lower</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Write-N-Cite v.2.5 for Mac</th>
<th>Write-N-Cite v.2 for Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Microsoft Word for Mac 2008 compatibility</td>
<td></td>
</tr>
<tr>
<td>- Mac OS X version 10.3 or later (including Leopard) compatibility</td>
<td></td>
</tr>
<tr>
<td>- Compatibility with Microsoft Word for Mac X and lower</td>
<td></td>
</tr>
<tr>
<td>- Mac OS X version 10.3 or earlier</td>
<td></td>
</tr>
</tbody>
</table>

For further information see: [http://www.refworks.com/refworks/wncdownload.asp](http://www.refworks.com/refworks/wncdownload.asp)

Download the Write-N-Cite plugin:

1. Login to RefWorks
2. Under the **Tools** menu at the top, click on the Write-N-Cite link
3. Click the link for the operating system you are using (Windows or Mac).
4. Click **Save** if another window appears (to save the program to your desktop)
5. Close RefWorks. You will automatically be logged out
6. For PC users:
   - Find the RefWorks plug-in on the desktop (**wncinstall.exe**) and click on it. Follow the instructions; click the buttons and Write-N-Cite will install itself using the installation wizard.
   - When asked to restart your computer, click **OK**
For Mac users:
   - The download should unstuff and the disk image should open automatically. If not, open the file **archive.sitx**, and then open the file **Write-N-Cite 1.0.dmg**.
   - Copy the application into the applications folder
7. After the computer restarts, open Microsoft Word and you will see the red Write-N-Cite button on the toolbar. It may be in the **Add-Ins** tab.

For help: [refworks@gelman.gwu.edu](mailto:refworks@gelman.gwu.edu)
Adding references to a new paper using the Write-N-Cite III for Windows:

1. Open Microsoft Word
2. Start working on your paper
3. When you get to a point in your paper where you need to enter a parenthetical reference, on your Word document, place the cursor between the last letter of the sentence and the period. Add a space between the two (just as though you were about to enter the parenthetical citation manually)
4. Click on the Write-N-Cite icon on the Word toolbar, then login to RefWorks. You'll have to do this even if you are already logged into Refworks from your web browser
   - **Mac users**: Launch the Write-N-Cite application located in the Applications folder.
5. In the Write-N-Cite window, check **Always on top**. This keeps the Write-N-Cite window on top of the Word document.
6. Go to the View Folder pull-down menu on the left-hand side and select the RefWorks folder with your references.
7. Choose any reference from your folder and click on the Cite link beside it. RefWorks will insert the citation in your document between curly braces: {{ [Ansell-Pearson, Keith 2002; ]

8. Continue writing your paper and using the Cite link to add more in-text citations as needed.

9. If you need to add page numbers or other text to an in-text citation, position your cursor anywhere within the curly braces in the citation in Word, then go to the Write-N-Cite window and click the Edit Citation link in the upper right-hand corner. A window will open providing a variety of options. Once you have made your changes, click Save to Word.

Note: To add page numbers to parenthetical citations in APA format, you will need to use the Text After box in the Edit Citation pop-up, not the Specific Page box. To do so, type a comma in the Text After box, followed by a space, followed by p. (or pp.), followed by another space and then the page number.

10. Using footnotes/endnotes using the Chicago 15th output style: In Word 2007, select References and select the appropriate type. In the footnote/endnote space, insert the citation from Write-N-Cite, as above.

11. Save this document. This is your master document. You will create a final version from this.
12. In the Write-N-Cite window, click on Bibliography
13. Under **Output Style**, choose the desired bibliographic style. (If you are using footnotes/endnotes, select the Chicago 15th Notes and Bibliography style.)
14. In the Write-N-Cite window, click Create Bibliography. Refworks processes your document, formatting your in-text citations and generating the bibliography/works cited list as specified by the selected citation style.

15. Save your Document.

For help: refworks@gelman.swu.edu
16. If you need to edit the full citations at the end of the document (i.e., the bibliography/works cited entries), you have two options:

a. For errors in the content of the citation (e.g., wrong author or year, misspelled title, unnecessary URL, etc.), make the change to the actual reference in your RefWorks account (NOT in Write-N-Cite). See above in this handout for how to edit entries in RefWorks.

b. If in proofreading your document, you may find errors in the format of a citation that you can’t fix by editing the entry in your RefWorks account: e.g., when applying APA style, RefWorks won’t capitalize proper nouns or acronyms in the titles of books or articles. To fix these, first save a copy of your document in Word. Then, in the Write-N-Cite window, go to Tools - Remove Field Codes. This will create a version of the Word document that you can edit freely, without interference from RefWorks. If you want to add more citations or change the citation style using Write-N-Cite, you will have to go back to the earlier (unedited) version.

REMEMBER: It’s your responsibility to make SURE everything is correct.

G. EXPORTING REFERENCES
Use this to save a copy of all your RefWorks references on your computer or to import these into another bibliographic management software such as EndNote or ProCite.

1. Click on References and then Export.
2. Select All References, My List or From Folder.
3. Select an Export format.
4. Click on the Export button.
5. You’ll be given the option to Save or to Open the resulting file. A window will also appear giving you the option to email the file to yourself if you prefer.

For more help, please feel free to send an email to refworks@gelman.gwu.edu

Revised December 2010

Gelman Library
18 May 2011